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RESUMO

Lucanus cervus, mais conhecido como vaca-loura em Portugal, € o maior escaravelho
da Europa, sendo protegido por leis comunitarias que requerem a criacdo de zonas
especiais de conservagado para a espécie. O estado de conservacdo da espécie em
Portugal, segundo o ultimo relatério do Instituto da Conservacdo da Natureza e das
Florestas, é Desconhecido, reflexo da falta de conhecimento sobre a sua distribuicédo e
efetivos populacionais no territorio nacional.

Em 2016 nasceu o Projeto VACALOURA.pt, um projeto de ciéncia cidada que
pretende compilar informacéo relativamente a esta espécie, motivando os cidadaos a
registar avistamentos da espécie em territério nacional. Apds dois anos de projeto, a
area conhecida em Portugal aumentou 45% e foi confirmada a sua presenca em 89%
do habitat conhecido até a data.

A modelacdo ecoldgica € uma area cientifica que permite identificar o peso de
variaveis ambientais que afetam a abundancia de espécies no territorio além de permitir
extrapolar a distribuicAo das mesmas num territorio consoante dados pontuais de
presenca.

O objetivo deste trabalho é identificar as varidveis ambientais que afetam a
distribuicdo da espécie Lucanus cervus em Portugal e modelar a sua distribuicdo
baseada nas mesmas.

Os resultados deste trabalho mostram que o tipo de solo e variaveis climaticas
como precipitagdo, amplitude térmica anual e temperatura média sdo as principais
variaveis que influenciam a distribuicao da espécie em Portugal, estando limitada a 30%
do territ6rio nacional, principalmente no Norte, mas com ilhas isoladas no Centro e Sul.

Esforcos séo necessarios para validar o modelo e confirmar a distribuicdo da
espécie nestas ilhas. Além disso, € necesséario aumentar o esforgco amostral no interior
do pais, onde ha poucos registos, mas o habitat apresenta elevada adequacédo de
ocorréncia segundo o modelo.



ABSTRACT

Lucanus cervus, known as “vaca-loura” in Portugal, its the largest beetle in Europa and
is protected by community laws that require the creation of Special Conservation Areas
for the species. According to the last report from the Portuguese National Environment
Conservation and Forestry Institute, the conservation state of this species in Unknown.
This reflects the lack of knowledge about the distribution and population numbers in the
Portuguese mainland.

In 2016, the VACALOURA.pt Project, a citizen science project that compiles data
regarding to this species, was born. The project motivates citizens to record their
sightings of the species in their webpage, using a special form. After two years of active
project, the known distribution area of the species in Portugal has increased in 45%, and
they were able to confirm the presence of the species in 89% of the known distribution
area to the present day.

Ecological modelling it's a scientific area that allows to identify the role of
environmental variables in the abundance of species in a determined area, and also
extrapolate their distribution based on known distribution points.

The purpose of this report is to identify the environmental variables that affect the
distribution of the European Stag Beetle in Portugal and model the distribution of the
species based on this data.

The results of this work show that the soil and climatic variable such as
precipitation, average temperature and thermal amplitude are the main variables that
influence the distribution of the species in the country. The species is limited to the
Northern third of the country but has some distribution islands in the Centre and South.

Efforts are necessary to validate the model and confirm the distribution of the
species in these islands. Furthermore, its necessary to increase the sampling effort in
the Eastern areas of the modelled distribution, where there aren’t that many records but
highly potential of occurrence.



INTRODUCAO

Lucanus cervus, mais conhecido como vaca-loura em Portugal, € uma espécie emblematica com
um elevado valor iconografico, devido a sua morfologia e dimenséo singulares, que a tornam facil
de identificar. Os machos medem entre trés e oito centimetros, séo facilmente reconhecidos pelas
suas proeminentes mandibulas em forma de pinga e o seu corpo apresenta tons principalmente
negros e acastanhados. Esta espécie tem uma distribuicdo ampla, ocupando praticamente toda a
Europa e parte do Médio Oriente (Harvey et al., 2011). Em Portugal ocorre sobretudo na metade
norte e centro do pais, mas existem registos pontuais a sul do rio Tejo, incluindo referéncias
historicas ndo comprovadas que reportam a sua ocorréncia no Alentejo (Grosso-Silva, 1999).

Figura 1 — Machos de Lucanus cervus a lutar. (©ORafael Marques)

A espécie esta associada a habitats florestais, principalmente florestas de folhosas com
presenca de arvores de porte elevado. No que diz respeito as espécies arbdreas preferenciais para
o desenvolvimento das larvas, tem sido reportada uma clara preferéncia por madeira de carvalho
em decomposicdo, em particular de carvalho-alvarinho (Quercus robur). No entanto, existem
igualmente registos em madeira de outras espécies, incluindo coniferas, como pinheiros Pinus
spp. (Harvey et al., 2011).



Esta espécie tem um ciclo de vida de trés a
cinco anos, durante o qual se desenvolve
desde um ovo até ao adulto, o qual vive
apenas cerca de um més.

A figura 2 representa o ciclo de vida
da espécie em apenas uma hora, estando o
adulto a voar apenas nos Ultimos cinco
minutos.

Apbs a eclosdo da larva do seu ovo
(5), esta comeca a alimentar-se de madeira
morta e vai acumulando reservas a medida
que vai crescendo. Quando chega a um certo
tamanho, deixa de comer, abandona a madeira
e enterra-se no solo para comegar a
metamorfose (8). Inicia entdo este processo,
transformando-se numa pupa (9). Ap6s algum
tempo, a pupa vai transformar-se no
escaravelho adulto, o qual vai permanecer no
solo (10) até que se registe o aumento da
temperatura no ano seguinte, momento em
gue saird do solo e procurard uma parceira
para acasalar, repetindo-se o ciclo (1-4).

© Maria Fremlin & Carim Nahaboo, 2014

Figura 2 — Representacao do ciclo de vida da
vaca-loura
(http://maria.fremlin.de/stagbeetles/index.html)

No que respeita & sua protecdo e conservagdo, Lucanus cervus consta do Anexo Il da
Diretiva Habitats (espécie cuja conservacdo exige a designacdo de zonas especiais de
conservacdo) e estd igualmente incluida no Anexo Il da Convengdo de Berna. Esti ainda
classificada como “Quase ameacada” (NT) pela Unido Internacional para a Conservacdo da
Natureza (Nieto & Alexander 2010).

Os relatorios de implementacéo da Diretiva Habitats, os quais tém que ser elaborados de
seis em seis anos, exigem um conhecimento aprofundado de varios parametros da biologia e
ecologia das espécies como a sua distribuicédo, efetivos populacionais, habitat ocupado, tendéncias
a curto e longo prazo (de distribuigdo, populacéo e habitat) e estado de conservagédo (avaliagdo
global). Alguns destes parametros (nimero de efetivos e tendéncias populacionais) tém que ser
determinados ndo s6 a nivel nacional como particularmente para o conjunto da rede Natura 2000.
A avaliagdo global para a vaca-loura constante do ultimo relatério nacional (correspondente ao
periodo 2007-2012) (ICNF, 2013) foi “Desconhecida” (XX), denotando a necessidade urgente de
obter mais informacdo para efetuar uma avaliacdo devidamente fundamentada.

VACALOURA pt (Figura 3) € um projeto 100% voluntério de ciéncia cidadd, que tem
como finalidade contribuir para a conserva¢do do Lucanus cervus e das restantes espécies de
escaravelhos da familia Lucanidae (Lucanus barbarossa, Dorcus parallelipipedus e Platycerus
spinifer Schaufuss, 1862) em Portugal, através de educacdo ambiental e da compilacdo de dados
sobre a distribuicdo e estado das suas populagdes. Nasceu de uma parceria entre a Associacdo
Bioliving, a Unidade de Vida Selvagem do Departamento de Biologia da Universidade de Aveiro
(UVS/DBio-UA), a Sociedade Portuguesa de Entomologia (SPEN) e o Instituto da Conservacéo
da Natureza e das Florestas (ICNF), fruto de um interesse partilhado e da combinacdo de
diferentes valéncias e areas de atuagdo de cada entidade para a conservagdo destas espécies.
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Figura 3 — Logotipo do Projeto VACALOURA.pt (www.vacaloura.pt)

Ciéncia cidadd € um termo adotado para designar o envolvimento dos cidaddos em
projetos de investigacdo cientifica, constituindo uma abordagem cada vez mais comum em
estudos a larga escala, principalmente de cariz ecol6gico e ambiental. A massificacdo do uso da
internet e de novas tecnologias veio facilitar o processo informativo e de recolha de dados,
permitindo a criacdo de ferramentas didaticas e a facilitagdo da comunicacdo com o publico
(Silvertown, 2009; Dickinson, Zuckerberg and Bonter, 2010). Os projetos cientificos alicercados
na participagao dos cidadédos tém, assim, a clara vantagem de permitir recolher dados a uma larga
escala espacial, de forma relativamente rapida, em periodos de tempo variaveis (incluindo tempo-
real), e com custos incomparavelmente inferiores aos das metodologias mais tradicionais, tendo
fornecido importantes contributos para o rapido avanco do conhecimento cientifico e da literacia
um pouco por todo o mundo (Bonney et al., 2009).

Desde o inicio do Projeto VACALOURA .pt, em 2016, foi possivel compilar 888 registos
de vacas-louras em territdrio nacional, sendo 290 provenientes de dados histéricos de ocorréncia
da espécie, 323 recolhidos durante 2016 e 275 em 2017.

Os dados recolhidos entre 2016 e 2017 permitiram aumentar em 45% o numero de
quadriculas (10x10km?) conhecidas da distribuigdo em Portugal (Figura 4 (b)). Permitiu também
confirmar que nos Gltimos dois anos a espécie foi avistada em 89% (Fig4 (c)) das quadriculas
onde é hoje em dia conhecida, algo interessante do ponto de vista da conservagéo da espécie, ndo
refletindo variages muito grande da &rea conhecida da espécie.
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Figura 4 — Distribuicdo dos avistamentos da espécie Lucanus cervus em Portugal (a) e consequente
mapa de distribuicdo da espécie, mostrando o aumento do conhecimento relativo a espécie com o projeto
VACALOURA .pt de 45% (b) e a confirmacao de distribuicdo em 89% das quadriculas conhecidas até &
data (c).



Apesar do aumento de informacdo anual relativamente a distribuicdo da espécie com a
vertente de ciéncia cidadd, ndo se sabe a verdadeira distribuicdo da espécie no territdrio nacional
de forma a inferir o verdadeiro estado de conservacao da espécie.

Este projeto tem como objetivos:

1) determinar as varidveis ambientais que mais afetam a distribuigao da espécie em Portugal;
2) modelar a distribuicdo da espécie no territério nacional conforme as varidveis
identificadas.

CARACTERIZACAO DA INFORMACAO USADA

Distribuicdo conhecida da espécie

A plataforma criada para se efetuarem os registos de avistamentos (www.vacaloura.pt/participar-
avistamento/) permite a recolha de diversos tipos de informacao relativamente ao avistamento do
escaravelho, sendo uma delas as coordenadas geograficas do local do avistamento em formato
WGS84 (Lat, Long).

Para obter 0 mapa de avistamentos, convertemos os dados para ETRS89-TMO6 utilizando
a plataforma (http://www.fc.up.pt/pessoas/jagoncal/coordenadas/) e posteriormente inserimos a
informacao no ArcGIS, exibindo a informacéo baseada na sua localizagdo geografica.

Selecdo de variaveis

A selecdo de variaveis foi feita principalmente por consulta bibliogréfica de trabalhos semelhantes
(Thomaes, Kervyn and Maes, 2008), mas também foram incluidas outras variaveis com
capacidade de afetar a distribuicdo da espécie. A descri¢cdo da influéncia de cada variavel no
modelo esta caracterizada na subsecgdo “Classificagdo das classes de valor e Reclassificagdo
espacial da variavel” dos Métodos.

Variaveis selecionadas inicialmente:

- Variaveis climéticas
- Temperatura média
- Temperatura maxima
- Temperatura minima
- Amplitude térmica
- Precipitacéo
- Distancia a solo com capacidade de suporte para a espécie
- Distancia a florestas com folhosas
- Elevacéo de terreno


http://www.vacaloura.pt/participar-avistamento/
http://www.vacaloura.pt/participar-avistamento/
http://www.fc.up.pt/pessoas/jagoncal/coordenadas/

Aquisicéo de dados

TABELA | - Dados necessarios para a constru¢do do modelo, fonte de aquisigédo dos

mesmos e estrutura inicial do ficheiro

Carta de ocupacao de solo

http://mapas.dgterritorio.pt/atom-
dgt/CDG_C0S2010v1_Continente_Atom.xml

DADOS FONTES DE DADOS Estrutura
ficheiro
Vetor
Distribuicdo Vaca-loura www.Vacaloura.pt (dados pessoais)
(pontos)
Vetor

(poligonos)

Modelo Digital de Terreno

http://www.fc.up.pt/pessoas/jagoncal/srtm/

< . Vetor
Q"Ii%ssggresm's com Gerados a partir da carta de ocupagéo de solo
(poligonos)
Temperatura média anual http://worldclim.org/version2 aiitf%)
Temperatura maxima http://worldclim.org/version2 aiitf%)
Temperatura minima http://worldclim.org/version2 aiitf%)
Amplitude térmica http://worldclim.org/version2 aiitf,:q)
L _ ; ) Raster

Precipitagédo http://worldclim.org/version2 (1x1km)

. i Vetor
Localidades http://www.openstreetmap.org/ (Pontos)
Carta Administrativa http://www.dgterritorio.pt/cartografia_e_geodesia/cartografia/ Vetor
Oficial de Portugal (CAOP) carta_administrativa_oficial_de_portugal__caop_/ (Poligonos)
Tino de solo http://geored.dge.mec.pt/informacao-geografica/atlas-digital-do- Vetor

P ambiente (Poligonos)
Raster

(30x30m)



http://www.vacaloura.pt/
http://mapas.dgterritorio.pt/atom-dgt/CDG_COS2010v1_Continente_Atom.xml
http://mapas.dgterritorio.pt/atom-dgt/CDG_COS2010v1_Continente_Atom.xml
http://worldclim.org/version2
http://worldclim.org/version2
http://worldclim.org/version2
http://worldclim.org/version2
http://worldclim.org/version2
http://www.openstreetmap.org/
http://www.dgterritorio.pt/cartografia_e_geodesia/cartografia/

Transformagao de variaveis

Os dados foram obtidos em diferentes formatos e estruturas e por isso foi necessario proceder a
uma transformacdo dos mesmos de forma a conseguir trabalhar com toda a informagéo no mesmo
Ambiente de Trabalho no ArcGIS.

A transformacéo dos dados decorreu da seguinte forma para cada variavel:

e TEMPERATURA MEDIA, MAXIMA, MINIMA e PRECIPITACAO

Os dados obtidos inicialmente continham informacéo para todo o globo e estavam organizados
para cada més do ano. Foi assim necessario transforma-los de forma a obter valores médios para
cada variavel para todo o territorio nacional.

A figura 5 explica o procedimento seguido relativamente a variavel “Temperatura
média”. A informacdo de cada més foi restrita ao territorio nacional (CLIP) e depois foi usada a
ferramenta “Raster calculator” para calcular o valor médio anual para cada pixel.

. 7 P ol Raster Calculator (SAT>Map Algebra)
avstemp danclio) Slip (Oh T Rastes Rartec Fpoesing) [ avetemp-ptoi it ] ((avgtemp_pt_1.tif +...+ avgtemp_pt_12.tif)/12) AVCTEMB BT HE

[ avgtemp (Fevereiro) ] 7/ Clip (DMT>Raster>Raster Processing) H avgtemp_pt_2.tif }

IGUAL PARA OS RESTANTES MESES

Figura 5 — Esquema conceptual do processo de transformacéo dos dados da temperatura média
(avgtemp = temperatura média).

O processo efetuado anteriormente foi repetido para as variaveis “Temperatura maxima”
(Fig.6), “Temperatura minima” (Fig.7) e “Precipita¢do” (Fig.8).

(e
. 2 = : 5 Raster Calculator (SAT>Map Algebra) /
TempMax (Janeiro) Sip bRt Rasten Riocesine) *{ tempmax pt 1.t } ((tempmax_pt_1.tif +...+ tempmax_pt_12.tif)/12) EMENA T

[ TempMax (Fevereiro) ] # Clip (DMT>Raster>Raster Processing) /—| tempmax_pt_2.tif I

IGUAL PARA OS RESTANTES MESES

Figura 6 - Esquema conceptual do processo de transformacéo dos dados da temperatura maxima
(TempMax = temperatura maxima).




3 i g i 7 : Raster Calculator (SAT>Map Algebra)
TempMin (Janeiro) Clip (DMT>Raster>Raster Processing) / [tempmm,pu .m’] ((tempmin_pt_1.tif +...+ tempmin_pt_12.tif)/12) TEMPMIN_PT.tiff

[ TempMin (Fevereiro) ]4 Clip (DMT>Raster>Raster Processing) /—| tempmin_pt_2.tif }

IGUAL PARA OS RESTANTES MESES

Figura 7 Esquema conceptual do processo de transformagdo dos dados da temperatura minima
(TempMin = temperatura minima).

A 5 } F Z Raster Calculator (SAT>Map Algebra)
avgPrec (Janeiro) Clip (DMT>Raster>Raster Processing) H avgprec_pt_1.tif H (avEhres BT avepest o2 rI12) AVGPREC_PT.tiff

Jr Portugal.shp

[ avgPrec (Fevereiro) ] ~/ Clip (DMT>Raster>Raster Processing) /—‘ﬂprec‘ptiz.tif }

IGUAL PARA OS RESTANTES MESES

Figura 8 - Esquema conceptual do processo de transformacao dos dados da precipitacdo média anual
(avgPrec = precipitacdo média).

e AMPLITUDE TERMICA

A transformagdo previamente efetuada relativamente a temperatura méaxima e minima foi
essencial para a aquisi¢do de informacdo sobre a amplitude térmica.

Foi necessario calcular a diferenca entre a temperatura maxima e a temperatura minima
de cada més (“Raster calculator”’) e posteriormente calcular a média das diferencas de cada més,
sendo o resultado deste calculo final a amplitude térmica média para o pais (Figura 9).

. . % ; Raster Calculator (SAT>Map Algebra) _ Raster Calculator (SAT>Map Algebra) =
TempMin (Janeiro) Clip (DMT=Raster>Raster Processing) [TempMm _pt_1.tif | (TempMax_pt_1_tif) - (TempMin_pt_1.tif) AmpTerm_pt_1.tif ((AmpTerm_pt_1.4f 1...t AmpTerm,_pt 12./12) AMPTERM_PT.tif

TempMax (Janeiro) |/ Clip (DMT>Raster>Raster Processing) /[ TempMax_pt_1.tif —— ]

IGUAL PARA OS RESTANTES MESES

Figura 9 - Esquema conceptual do processo de transformacéo dos dados da amplitude térmica
(TempMin = temperatura minima, TempMax = temperatura maxima, AMPTERM= Amplitude térmica).




e DISTANCIA AO TIPO DE SOLO PROPICIO

Foi efetuada uma andlise a frequéncia de avistamentos por tipo de solo a nivel nacional (TABELA
I1). Os resultados mostraram que ha uma predominancia por um tipo de solo em particular
(Cambissolos humicos) e por isso foi optado pela utilizacdo da distancia a este tipo de solo para
representar esta variavel.

TABELA Il — Distribuicdo das amostras consoante o tipo de solo.

Tipo de solo Amostras %
Cambissolos hiimicos 749 85.02
Outros 139 14.98

Para estimar a distancia a este tipo de solos foi necessario efetuar uma selecdo por
atributos, onde foram selecionados os poligonos do ficheiro inicial com o tipo de solo pretendido
(Figura 10).

Apos exportar esta selecdo, efetuou-se um processo de analise espacial de distancia
(“Euclidean distance ”) que permite obter um novo ficheiro, em raster, com valores referentes a
distancia do pixel ao poligono inicial.

solos,shp ﬁ/ Select by attribute (=Cambissolos hiimicos) / { solo_suit.shp H Euclidean distance H dist_solo_suit.tif ]

Figura 10 - Esquema conceptual do processo de obtencdo de dados relativamente a distancia ao tipo de
solo propicio para o desenvolvimento da espécie.

e DISTANCIA A FLORESTAS DE FOLHOSAS

Para determinar a distancia dos pontos a florestas com folhosas foram previamente selecionados
todos os poligonos da carta de ocupagao de solo que continham informacéo relativamente a esta
variavel utilizando a selecdo por atributos.

Os dados foram posteriormente exportados para uma nova shapefile e a partir desses
dados foi efetuada uma anélise de distancia euclidianas que nos permitiu obter um ficheiro final,
em formato raster, em que a informacao de cada pixel era a distdncia do mesmo aos poligonos
previamente selecionados (Figura 11).

/ Select by attribute (todas as camadas com . i . i ]
cos.shp espécios de anvores folhiosas na Heserizio) /LI cos_flor.shp H Euclidean distance H dist_cos_flor.tif
Figura 11 - Esquema conceptual do processo de obtencgdo de dados relativamente a distancia a florestas
de folhosas.
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METODOLOGIA

Selecdo do modelo
O modelo de Potencial de Ocorréncia da VVaca-Loura (POVL) foi definido como:

POVL = 0.70%[DS]+0.15*[ TM]+0.05* AMPT]+0.10*[P]

Em que:
e [DS]: Distancia ao tipo de solo propicio;
o [TMI: Temperatura média anual;
e [AMPT]: Amplitude térmica;
o [P]: Precipitacdo media anual;

Das variaveis analisadas anteriormente optou-se por eliminar a distancia a florestas de
folhosas por levarem a um desempenho negativo no modelo (Ver em detalhe na Validagdo do
Modelo - Resultados). A eliminagdo desta variavel permitiu também simplificar o modelo.

Consoante o valor de potencial de cada pixel, estes foram classificados com maior ou menor
POVL segundo os valores da Tabela I11.

TABELA Ill - POVL consoante os valores obtidos no modelo
POVL Classe de potencial
Muito Baixo 0-20
Baixo 20-40
Médio 40-60
Alto 60-80
Muito Alto 80-100

Para chegar a este modelo foi efetuado:
1) uma andlise estatistica das variaveis de forma a eliminar correlacdes;

2) uma classificagdo dos valores de cada varidvel consoante a maior ou menor
potencialidade de ocorréncia segundo a distribuicdo da espécie em Portugal.

A atribuicdo de pesos as variaveis foi feita por tentativa erro, alterando os valores
consoante os resultados de cada modelo de forma a melhorar o seu desempenho. A analise de
desempenho foi feita por cross-validation com os dados utilizados para criar o modelo.
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Analise estatistica

A partir da localizacdo geografica de cada ponto conhecido de avistamento da espécie foi inferido
o valor das variaveis selecionadas inicialmente nesse local utilizando a ferramenta “Extract
Values to Points” (Spatial Analyst tools>Extraction). Esta ferramenta permite extrair para a
tabela de atributos da shapefile de pontos o valor do pixel do raster que sobrepdem. Este processo
permite obter informacg&o sobre as variaveis no local de avistamento da espécie.

Ap0s a transformacéo dos dados e estimativa do seu valor para cada ponto, foi efetuada
uma andlise de correlacdo entre variaveis climéaticas (TABELA 1V) de forma a eliminar variaveis
gue sdo redundantes e assim simplificar o modelo.

Desta analise, optou-se por usar no modelo apenas as variaveis Amplitude Térmica (por
ndo apresentar correlacdo com nenhuma outra variavel) e Temperatura Média (por apresentar
correlagdes superiores a 70% com as restantes, sendo assim representativa das mesmas).

TABELA IV — Andlise de correlacdo entre variaveis climaticas.
Temperatura Temperatura Temperatura Amplitude
média maxima minima térmica

Elevacao

Elevagéo 1

Temperatura media -0.91857 1

Temperatura maxima -0.83773  0.923202 1

Temperatura minima  -0.86098  0.903307 0.715506 1

Amplitude térmica -0.18115 0.252694 0.580254 -0.15379 1

Apos a anélise de correlagdo entre as varidveis, foi necessario efetuar analises estatisticas
das que néo foram eliminadas (TABELA V), de forma a perceber melhor a distribui¢do dos seus
valores nos locais de avistamento da espécie e assim definir as classes de valores.

TABELA V — Andlise estatistica das variaveis restantes

Te,m_peratura Amp!itude Precipitacdo Distancia a florestas
média térmica com folhosas

Média 13.96 9.30 106.58 237.99

Erro-padréo 0.04 0.03 0.58 9.18

Mediana 14.19 9.43 111.00 162.41

Moda 13.92 9.57 116.00 0.00

Desvio-padrdo 1.05 0.90 17.25 273.57

Variancia da amostra 1.10 0.81 297.43 74840.44

Minimo 9.03 5.76 55.00 0.00

Méximo 16.38 11.54 149.00 1902.81

Para a variavel “Distancia ao tipo de solo propicio” ndo foi efetuada uma analise
estatistica, mas sim um levantamento bibliogréfico da capacidade de deslocagao da espécie.

Foi ainda elaborada uma analise visual da distribuicdo dos dados em histogramas para
perceber se havia alguma tendéncia nos dados. Esta tendéncia foi também importante para definir
0 peso a dar a cada variavel, tendo varidveis com mais dados distribuidos em menores intervalos
maior peso no modelo, por mostrarem uma especificidade maior da espécie a variavel.
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FIGURA 12 — Frequéncia de amostras em cada classe da variavel em questéo.
([TM] = Temperatura média; [AMPTERM] = Amplitude térmica, [P] = Precipitacéo,
[DFLOR] = Distancia a florestas de folhosas)

Classificacéo das classes de valor e reclassificagdo espacial da variavel

Para cada variavel as classes de valor para posterior reclassificacdo das variaveis foram definidas
consoante os intervalos entre o valor médio da variavel e desvios padrdes:

TABELA VI — Distribuicdo de valor de potencialidade consoante os valores da variavel

POVL Valor Classes de valor

Elevado 100 [-1DP;1DP]

Médio 66 [-2DP;-1DP] e [1DP;2DP]
Baixo 33 [-3DP;-2DP] e [2DP;3DP]
Nulo 0 [Min;-3DP] e [3DP;Max]

Onde: DP = Desvio Padrdo; Min = Minimo da variavel e Max = Maximo da variavel

Apos a classificagdo dos valores das varidveis em classes foi efetuado um processo de
reclassificagdo dos pixels do raster de forma a tomarem o valor de Potencial de Ocorréncia. Este
processo foi efetuado com a ferramenta “Reclassify” (Spatial Analyst Tools > Reclass).
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As classes de valor para cada varidvel foram definidas como:
Temperatura média

O facto da espécie Lucanus cervus ter um ciclo de vida longo relativamente a outras espécies de
insetos (3-4 anos), leva-o a ser sensivel a variacOes climaticas.

A temperatura do ar é um fator limitante ao crescimento dos insetos uma vez que estes obtém
todo o calor corporal de fontes externas, ndo tendo a capacidade de o produzir. Sendo assim,
locais muito frios ou muitos quentes tendem a ndo ser propicios a ocorréncia de insetos.

A temperatura média do ar é assim uma variavel com capacidade de influenciar a distribuicdo
desta espécie.

Segundo os dados de distribui¢do da espécie, o potencial da sua ocorréncia varia consoante as
classes de valor definidas na TABELA VII. A figura 13 mostra a distribui¢do das classes ao longo
do territorio.

Tabela VIl — Classes de valor de maior e menor POVL consoante a
Temperatura média em Portugal.

POVL Valor Classes de valor

Elevado 100 12.92 - 15.01

Médio 66 11.87 - 12.92 ; 15.01 — 16.06
Baixo 33 10.82 -11.87 ; 16.06 — 17.11
Nulo 0 6.27 -10.82 ; 17.11-17.86

Legenda

[ Distritos

Temperatura média (°C) v p:

<VALUE> i RS TR, Legenda

B o2 1052 J 5 B | Distritos

[Jiws2-187 i/ fl S 2 o Temperatura Média (°C)

B 1167 - 1292 . 1 Value
12.92-15.01 YS! 4 °

= 15.01-16.06 < 5 33

[ J1606-17.11 [ s

| EIAIRRTE B 00

012525 Kilometers. 0 12525 Kilometers
[} S

Figura 13 — Classes de valor de maior (vermelho) e menor (verde) POVL (a) e posterior reclassificacéo
dos dados para utilizagdo no modelo (b) para a variavel “Temperatura média”
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Amplitude térmica

Sendo uma espécie sensivel a variagdes climaticas, as variages térmicas em determinado local
poderdo influenciar também o seu desenvolvimento.

A amplitude térmica pode ser vista como uma medida da variacdo da temperatura em cada local
e por isso é importante na distribui¢do da espécie.

Segundo os dados de distribuicdo da espécie, o potencial da sua ocorréncia varia consoante as
classes de valor definidas na Tabela V1I1. A Figura 14 mostra a distribuicdo das classes ao longo
do territorio.

Tabela VIII — Classes de valor de maior e menor POVL consoante a
Amplitude térmica em Portugal.

POVL Valor Classes de valor

Elevado 100 8.41 -10.20

Médio 66 7.51-8.41;10.20-11.10
Baixo 33 6.61-7.51;11.10-12.00
Nulo 0 4,01-6.61;12.00-13.01

Legenda

[ Distitos

Amplitude térmica (°C)

<VALUE> Legenda

I < .008332253 - 6.61 [ oistitos

[ ss10000001-7.51 Amplitude térmica (°C)
[ 7 510000001 - 8.41 <VALUE>

I 5410000001 - 102 I o

[ 1020000001 - 111 [Ja

[ 1.10000001 - 12 [ s

I 12.00000001 - 12.74166303 B 00

0 20 40 Kiometers 0 20 40 Kiometers
I —| | S—E—

Figura 14 — Classes de valor de maior (vermelho) e menor (verde) POVL (a) e posterior reclassificacdo
dos dados para utilizagdo no modelo (b) para a variavel “Amplitude térmica”.
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Precipitacéo

A precipitacdo de um local tera influéncia direta nas espécies de flora que ocorrem no local e por
isso, neste caso, indiretamente na quantidade de alimento disponivel para a espécie.

Além disso, as condicGes fisicas do solo dependem em grande parte da quantidade de agua
disponivel no mesmo. Como vimos, o tipo de solo é uma variavel que tem grande influéncia na
distribuicdo da espécie e por isso esta variavel influenciard diretamente a sua capacidade de
desenvolvimento.

Segundo os dados de distribuicdo da espécie, o potencial da sua ocorréncia varia consoante as
classes de valor definidas na Tabela IX. A figura 15 mostra a distribui¢éo das classes ao longo do
territorio.

Tabela IX — Classes de valor de maior e menor POVL consoante a
Precipitacdo em Portugal.

POVL Valor Classes de valor

Elevado 100 89.34 - 126.00

Médio 66 72.11 —89.34 ; 126.00 — 141.05
Baixo 33 54.87 —72.11 ; 141.05 — 158.29
Nulo 0 38.00 —54.87 ; 158.29 - 171

Legenda

[ oistitos
Precipitacdo média
<VALUE>

B 555487

[ 5487000001 - 72.11

[ 72 11000001 - 89.34

Legenda

[ Distritos

Precipitagdo média
Value

I 55.34000001 - 123.82 I
[ 123 8200001 - 141.05 [J=
[ 141.0500001 - 158.29 I &5
I 1582000001 - 160 B 100

0 20 40 Kiomelers 0 20 40 Kiomelers
— —

Figura 15 — Classes de valor de maior (vermelho) e menor (verde) POVL (a) e posterior reclassificacdo
dos dados para utilizagdo no modelo (b) para a variavel “Precipitagdo média”.
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Nas variaveis de distancia foi definido que a distribuicdo do valor das classes seria definida de
forma diferente, uma vez que ao subtrair o valor do desvio padrdo mdltiplas vezes foram obtidos
valores negativos.

Sendo assim, a atribuicdo de classes foi definida como:

Tabela X — Classes de valor de maior e menor POVL para variaveis de distancia.

POVL Valor Classes de valor
Elevado 100 [-0;1DP]

Médio 66 [1DP;2DP]
Baixo 33 [2DP;3DP]

Nulo 0 [3DP;Max]

Onde: DP = Desvio Padrdo; Min = Minimo da variavel e Max = Maximo da variavel
Distancia a Florestas de Folhosas

A espécie Lucanus cervus tem uma dependéncia direta por espécies de arvores folhosas,
principalmente carvalho-alvarinho (Quercus robur), mas também outras espécies com
caracteristicas semelhantes, para se alimentar e desenvolver.

Foram definidas as florestas de folhosas como uma possivel representacéo desta variavel, sendo
apesar de ser uma representacao um pouco generalista. A distancia a este tipo de florestas pareceu-
nos uma variavel interessante, representando a capacidade de deslocacgdo da espécie.

Segundo os dados de distribuicdo da espécie, o potencial da sua ocorréncia varia consoante as
classes de valor definidas na Tabela XI. A figura 16 mostra a distribuicdo das classes ao longo do
territorio.

Tabela X| — Classes de valor de maior e menor POVL consoante a
distancia a florestas de folhosas em Portugal.

POVL Valor Classes de valor
Elevado 100 0-511.40

Médio 66 511.40 — 784.82
Baixo 33 784.82 — 1058.23
Nulo 0 1058.23 — 1902.81

Legenda
o
Disténcia Florestas
<VALUE>

U

=

=

I

LR O
[l '

Legenda
Dixlye

Distincia Florestas

Figura 16 — Classes de valor de maior (vermelho) e menor (verde) POVL (a) e posterior reclassificagdo
dos dados para utilizagdo no modelo (b) para a variavel “Distancia a Florestas de Folhosas”.
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Distancia ao tipo de solo propicio

O tipo de solo afeta diretamente a capacidade de desenvolvimento da espécie uma vez que esta
passe grande parte do seu ciclo de vida no mesmo, tanto a se alimentar como a metamorfosear.

Como referido anteriormente, a definicdo dos intervalos de maior e menor POVL relativamente
a distancia ao tipo de solo propicio foi efetuada consoante informacao recolhida por referencias
bibliogréaficas.

Segundo Rink and Sinsch (2007), esta espécie ndo consegue voar mais de 700 metros de uma sé
vez, tendo a capacidade de se deslocar raramente até 3km ap6s uma série de voos. Com base
nestes valores as classes de valor de potencial de ocorréncia foram definidas como constam na
TABELA XII. A classe foi definida como menor que 700 metros uma vez que mesmo estes voos
sdo raros, sendo 500 um valor intermédio que demonstra um meio termo credivel. A Figura 17
mostra a distribuicdo das classes ao longo do territorio.

Tabela Xll — Classes de valor de maior e menor POVL consoante a
distancia ao tipo de solo propicio em Portugal.

POVL Valor Classes de valor
Elevado 100 0-500

Médio 75 500 - 1000
Baixo 50 1000 — 2000
Muito baixo 25 2000 — 4000
Nulo 0 > 4000

Legenda Legenda

__ Distritos ___ Distritos
Distancia a solo Distancia a solo
<VALUE> <VALUE>

I 0 - 500 B o

500- 1 000 I 25

[ J1000-2000 [ Je

[ 2000- 4 000 7%

I < 000 - 142233.0625 B o0

0 20 40 Kiometers 0 20 40 Kilometers
— { E S |

Figura 17 — Classes de valor de maior (vermelho) e menor (verde) POVL (a) e posterior reclassificacdo
dos dados para utilizagdo no modelo (b) consoante a variavel “Distancia a tipo de solo propicio”.
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RESULTADOS

Mapa de Potencial de Ocorréncia da Vaca-Loura em Portugal
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Figura 18 — Representacéo cartografica do melhor modelo para o Potencial de Ocorréncia da espécie
Lucanus cervus em Portugal.

O modelo final escolhido foi representado cartograficamente em raster (com pixel de 1x1km)
(Figura 18) e a area de cada classe de POVL pode ser vista na TABELA XIlII.

TABELA XllI- Area de cada classe de POVL em Portugal.

POVL Area em km? Percentagem (%)
Muito alto 34925 26.6

Alto 4089 3.1

Médio 4472 3.4

Baixo 14612 11.1

Muito baixo 73400 55.8

Validagdo do modelo

O processo de validagdo do modelo foi efetuado por uma anélise de cross-validation com os dados
utilizados para criar o modelo.

Foi um processo repetido varias vezes no processo de melhoramento do modelo, e onde foi
calculada a percentagem de pontos que se encontravam em areas com maior valor de POVL. A
TABELA XIV mostra a distribuicdo do peso das variaveis para cada modelo testado e
consequente percentagem de pontos na classe de maior POVL.
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TABELA XIV — Performance do modelo consoante o peso atribuido as diferentes variaveis
preditivas de potencial de ocorréncia da espécie.

MODELO
VARIAVEL 1 2 3 4 5 6 7 FINAL

< [DS] 9 80 80 80 70 70 70 70

8 | [DFLOR] 25 5 33 2 33 3 0 0

3 T [AMPTERM] 25 5 33 5 33 75 75 5

%é‘g—; [TM] 25 5 10 10 20 15 15 15

o 0> [p] 25 5 33 3 33 45 75 10

%AVIST> 80% POVL 83 83 83 8 8 8 8 87

O processo de atribuir peso as variaveis iniciou-se por dar bastante peso (90%) a variavel distancia
ao tipo de solo propicio e ir retirando ao longo do desenvolvimento do modelo para perceber
como afetaria 0 mesmo. Ao longo do processo de calibragcdo com as validagfes, foram também
dados pesos diferentes as varidveis de forma a perceber como tais alteracGes influenciariam o
modelo.

No modelo 7 eliminou-se a varidvel distancia a florestas com folhosas uma vez que ndo afetaria
0 modelo. Neste passo viu-se também que um maior peso a precipitacdo levou a uma manutengéo
da performance do modelo. Optou-se por aumentar mais um pouco esta variavel, o que levou a
uma melhor performance do modelo.

Optou-se por manter este modelo como final, uma vez que a diminuicdo do peso sobre outras
variaveis nos pareceu ja uma sobrevaloracdo de outras a0 mesmo tempo que o0s resultados nos
pareceram bastante satisfatorios e dificeis de melhorar.

Analise de resultados

O processo de validacdo do modelo mostrou-nos que uma grande parte dos dados se encontra em
areas de POVL muito alto, o que leva a crer que o modelo se adequa & distribui¢do da espécie no
N0SSO pais.

Além disso, é interessante descobrir que apenas o terco mais a norte do pais (TABELA XIlII e
Figura 18) tem elevado potencial de encontrar a espécie, tornando necessérias acbes de
conservacao da espécie nestas areas.

Segundo o modelo, existem trés locais bastante isolados da zona central de distribuicdo da espécie
onde esta podera também ocorrer, sendo estes a Serra de Sintra, a Serra de Monchique e a Serra
de S8 Mamede. Numa destas “ilhas”, em Sintra, é possivel encontrar vacas-louras com
frequéncia no verdo, ndo se sabendo se 0 mesmo ocorre nos restantes locais.

Apesar do elevado nimero de avistamentos conhecidos na area de maior POVL refletir que este
modelo se adequa a realidade, continua a haver uma parte dos dados que se encontram na area de
menor POVL. Além disso, os dados parecem estar bastante limitados a zonas mais perto do litoral,
apesar de haver o mesmo POVL em zonas mais interiores do pais. Isto pode ser reflexo da maior
quantidade de pessoas nestas regides, que leva a um aumento de avistamentos desta espécie nestes
locais.

Além disto, seria interessante perceber melhor a distribuicdo dentro da zona de maior POVL uma
vez que este modelo foi elaborado de forma a adequar-se aos dados que temos. Desta forma
conseguiriamos também perceber melhor a razdo para os dados estarem mais distribuidos na zona
litoral, como referenciado anteriormente.
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CONCLUSOES e PROPOSTAS DE MELHORIA

As varidveis com maior peso na distribuicdo da espécie Lucanus cervus em Portugal sdo a
distancia ao tipo de solo propicio, a temperatura média do ar, a precipitacdo média anual e a
amplitude térmica, respetivamente limitando a sua distribuicdo ao ter¢o norte do pais, com 3 ilhas
isoladas no Centro e Sul do Pais.

O modelo criado aparenta uma forte relagdo com os dados de distribuicdo conhecidos da espécie,
tornando-o bastante interessante do ponto de vista de conservacao futura deste invertebrado.

O modelo indica também novas areas de distribuicdo com elevado potencial para encontrar a
espéecie onde esta nunca foi vista. Esforcos futuros poderdo ser efetuados nestes locais para
confirmar estes registos.

Uma aposta de divulgacdo do projeto em zonas com menos populacdo poderé trazer novos
resultados interessantes para o conhecimento sobre esta espécie em Portugal.

A criagdo de um modelo que contemple as condi¢Ges ambientais numa zona circundante ao local
de avistamento da espécie, tendo em conta a abundancia de avistamentos por local podera trazer
informacdo bastante mais detalhada para a conservacdo deste invertebrado e por isso esforgos
nesse sentido devem ser feitos.

Apesar do modelo apresentar uma performance bastante positiva em relagdo aos dados
conhecidos, existem locais que este indica haver pouco POVL contrariamente ao esperado por
existem registos da espécie todos os anos (zona do baixo Mondego).

Este exercicio foi bastante recompensador do ponto de vista pessoal, uma vez que permitiu
perceber melhor as varidveis ambientais que esta espécie depende no nosso pais, permitindo
melhor esforgos futuros de modelacgao da espécie baseados nas variadveis ambientais das zonas de
maiores avistamentos e ndo dos locais concretos onde é observado.
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